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1 Preconditions

The following preconditions must be met to ensure proper mode of oper-
ation:

￭ Empower® is installed according to the Waters instructions. Refer to
the Waters instructions for information concerning the minimum sys-
tem requirements.

￭ The Metrohm driver is installed according to the instructions
(8.0102.8001EN Metrohm IC Driver 2.1 for Empower® Installation).
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2 Starting Empower®

Starting Empower®

 

1 Connect the Metrohm instruments via USB to the PC. Connect the
Metrohm instruments to the power supply unit.

 

2 Switch the PC on.

 

3 Switch the Metrohm instruments on.

 

4 Start Empower® by clicking on the corresponding icon on the desk-
top.

NOTE

Ensure that all Metrohm instruments are switched on before start-
ing Empower®. In case of issues while starting Empower®, see
Chapter 16, page 113.

 

5

Enter your Empower® user name and password. Click on [OK].
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NOTE

If you have a client server installation, choose your database.

2.1 Configuring the system

1

Click on [Configure the System].

The configuration manager opens. Its icon appears and blinks in the

lower task bar of your screen. 

 

2 Go to Nodes.
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3

Select a node. Right-click on the respective node. Open the
Properties menu item of the connected instrument. The connection
to the node will be established.

NOTE

If the node does not exist yet, create a new node (see "Creating a
node ", page 9).
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4

Click on [Configure DHCP] on the Configure DHCP tab.

 

5

Click on [Add...].

 

6 Enter the following parameters:
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NOTE

If several systems are added, the IP address and the MAC
address, have to differ.

NOTE

You must power on all systems that are configured on the DHCP
Server.

Parameter Value

IP Address 000.000.000.xxx, (where xxx =
001-255) e.g. start with
000.000.000.001

MAC Address 00-00-00-00-00-xx, (where xx =
00-99) e.g. start with
00-00-00-00-00-01

Instrument Type Select Metrohm IC. This
includes all implemented Met-
rohm instruments, also sample
processors and dosinos.

Serial Number / Unique Name These are the actual settings
used to detect the instrument
on the USB bus. They must
meet the requirements descri-
bed in the next section.

Requirements for the Serial Number / Unique Name:

The serial number must be the last six characters (including leading
0s) printed on the serial number sticker found on the back of the
instrument.

NOTE

You cannot find the serial number of the IC Sample Center on the
instrument. Please contact a Metrohm service engineer, if you
need to know the number of your sample center.

Prefix the serial numbers with the following abbreviations:
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Instrument Prefix

IC-instrument (e.g. 940) IC=

Professional Sample Processor
(e.g. 858)

SP=

IC Sample Center (e.g. 889) SC=

Professional Detector Vario
(Stand Alone) (e.g. 945)

DT=

Professional UV/VIS Detector
(e.g. 944)

UV=

Eluent Production Module (e.g.
941)

EL=

If you are using multiple instruments, you can combine them. See
Chapter 17, page 114 for possible combinations. In this case, sepa-
rate the serial numbers by a space. The order of the different mod-
ules is freely selectable.

Table 1 Examples

Instrument Prefix

IC only IC=003127

SP only SP=003534

SC only SC=100062

DT only DT=004101

Combination IC=003127 SC=100062
DT=004101 UV=001536
EL=100897

 

7 Example:



2.1 Configuring the system ￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭

8 ￭￭￭￭￭￭￭￭

When entered the values, click on [OK].

 

8

Click on [OK].
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9

Click on [OK].

Creating a node 

Usually the required node already exists. If this is not the case, it is neces-
sary to create a new node.

 

1 Go to Nodes in the configuration manager.
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2

Create a new node (i.e. where your instruments are connected to the
PC). For this purpose, right-click on the table and click on
New ▶ Node.

 

3

Enter the name of the node. Choose your timezone. Click on
[Finish].
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2.2 Removing an instrument 

1

To remove an unused instrument, select the instrument by clicking on
the number of the corresponding row and click on
[Remove Instrument].
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2

Click on [Configure DHCP] on the Configure DHCP tab.

 

3

Select the instrument you want to remove. Click [Remove].

 

4 Reboot the computer.
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3 Setting up a chromatographic system

1

Go to Systems.

Create a new system by selecting the menu item New ▶ Chromato-
graphic System.
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2

Select Create New System. Click on [Next].

Table 2 Detailed explanations

Field Explanation

Create New System Specifies that you create a new
chromatographic system using
available instruments connec-
ted to an acquisition server. It is
not necessary that the system is
directly connected to your
Empower® workstation.

Connect to Existing System Specifies that the current user
can access the selected chro-
matographic system. If the sys-
tem is password-protected, you
need the password to access
the system. Then you can use
the chromatographic system to
acquire and process data and
to generate reports.

 

3 Click on [Next].

 

4 Choose (client/server) acquisition server.
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In case of a client/server installation, select the node on which the
Metrohm IC Driver for Empower® was installed.

Click on [Next].

 

5

Select an instrument from the Available Instruments list. Drag the
instrument to the list beneath New System Instruments. You can
use instruments from the Unused Components and an existing sys-



￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭

16 ￭￭￭￭￭￭￭￭

tem. If the instrument is not in the Available Instruments list, click
on [Cancel] and check the properties of the acquisition server.

Click on [Next].

NOTE

You cannot drag the last instrument from an existing system. To
free up the last instrument, delete the system.
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6

If you have access to a chromatographic system, you do not need to
enter the password unless you are crossing databases.

If required, enable the fields under Allow Access to Group(s).

Detailed explanations

Table 3 Share System with Other Network Users

Field Explanation

Share System with Other Net-
work Users

Specifies that other network
users (determined by the access
option you select (see Table 4,
page 18)) can use the system.
If you select this option, con-
sider password-protecting the
system to limit its use to
authorized users.
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Table 4 Allowed Access

Field Explanation

Owner Only Specifies that the owner of the
chromatographic system and
users with administrator rights
can access the selected chro-
matographic system.

Owner and Group(s) Specifies that the owner of the
chromatographic system, group
members as specified in the
Allow Access to Group(s) list
and administrators can access
the selected system. Group
access only allows a user to
operate a chromatographic sys-
tem.

Note: To modify a chromato-
graphic system, you need
access to the chromatographic
system and its acquisition
server.

Owner, Group and World Specifies that all users in the
database can operate the selec-
ted chromatographic system.

Table 5 Password Protect System Access

Field Explanation

Password Required Specifies that users enter a
password before they can
access the selected chromato-
graphic system across databa-
ses.

Password Specifies that you need a pass-
word (up to 30 alphanumeric
characters) to access the selec-
ted chromatographic system
across databases.

Confirm Password Requires reentry of the pass-
word to confirm that you spel-
led it correctly.
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Table 6 Allow Access to Group(s)

Field Explanation

Allow Access to Group(s) Select the user group(s) that
you want to give access to the
selected chromatographic sys-
tem. Access rights of these user
groups override access rights of
the selected world user type. If
you select
Owner, Group and World,
groups that you did not select
in the
Allow Access to Group(s) list
are assigned the world user
type access.

Click on [Next].

 

7

Enter a system name and click on [Finish] to complete the setup of
the new chromatographic system and to close the wizard.
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Table 7 Detailed explanations

Field Explanation

System Name Identifies the chromatographic
system in the Empower® data-
base and in the
Configuration Manager. Up
to 30 alphanumeric characters
are allowed for the system
name. Use a meaningful system
name in case other users have
access to the system.

Node Name Name of the acquisition server
to which the selected system is
connected. This field is not edit-
able.

Online If all configured system instru-
ments are available (not config-
ured in another online system),
this brings the new system
online. Default value: selected.

System Comment Displays optional comment (up
to 250 characters). Comments
that describe the chromato-
graphic system, its components
and its intended use can help
others if they have access to
the system.

 

8 The following message appears.

Click on [OK].
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9

Check if the system is online. If not, bring it online by right-clicking
on the system and clicking on Bring Online.

NOTE

The number of instruments, which can be online at the same time,
depends on the Empower license.
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4 Creating a project

1

Create a new project by selecting the menu item New ▶ Project.

 

2 The Tablespace form appears.
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Click on [Next].

 

3

Click on [Next].
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4

Click on [Next].

 

5
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In the Projects tree view, select an appropriate project for already
existing settings.

Click on [Next].

 

6

Enter a Project Name.

Click on [Finish].
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5 Creating an instrument method

NOTE

You can only use an already existing instrument method with the same
system configuration the instrument method has been created with.

NOTE

This manual shows you how to create an instrument method by using
the pro interface. For a quick set up of an instrument method, click on
[Use QuickStart]. The basic principle for the quickstart is the same as
described in the following procedure.

1

In the Empower® start window, go to [Run Samples].
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2

Choose your chromatographic system and the desired project. Click
on [OK].

A Run Samples session is initiated. The corresponding icon in the

task bar appears. 

 

3

Wait until the instrument status changes from INITIALIZING to
IDLE. This may take several minutes.

If the instrument does not become IDLE, refer to chapter 16, page
113.
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4

As soon as the instrument status has changed to IDLE, select
Edit ▶ Instrument Method.

 

5

The instrument method shows all modules of your setup in a tree
structure. Select a module and enter the desired instrument parame-
ters (see Chapter 6.1.2, page 30).
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Customize the status panel

 

1

Click on [Customize] in the status panel.

 

2

In the Customize tab, you can select the information, which the sta-
tus panel shows.
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6 Adjusting the instruments

6.1 General

6.1.1 Status panel and manual control 

Status panel

The Status panel displays the current state of the instrument and its mod-
ules. For further information concerning the numbering of the modules
refer to Chapter 14, page 108.

Manual control

Under Manual Control, you can operate all hardware components indi-
vidually (only when no measurement is running). The manual control is
located next to the status panel.

6.1.2 Instrument parameters 

Setting the instrument parameters

NOTE

Instrument parameters are sent to the instruments when you start the
method.

 

1

Select a module of the created instrument method. Enter the desired
instrument parameters.
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NOTE

The selection option with the tabs depends on the instrument
types.

 

2

To set the parameters for an instrument, you first have to activate the
instrument by checking the checkbox Active.

6.1.3 Time program 
Write a time program to set the chronological order of the action of your
measurement.

Select commands with [Add...].

Time program – Example 

To start a simple time program, you can proceed as follows:
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1

Select an instrument and a command.

 

2 Enter the required parameters. Which parameters you need to enter
depends on the command that you selected.

 

3

The picture shows what the time program looks like.

Actions of indefinite time are highlighted in gray in the time pro-
gram. The time counter restarts at 0 after such a command.

Add more lines with [Add…].

 

4 Save your instrument method.
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Device-independent commands are commonly used for the execution of
subprograms. Use subprograms to create more complex time programs.

6.2 IC instrument

6.2.1 Status panel and manual control 

The status panel displays the current state of the IC instrument.
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Operate all hardware components individually in the manual control of the
IC instrument.

6.2.2 Instrument parameters 
The following screenshots show instrument parameters for a typical anion
setup.

IC instrument – Gra-
dient

The following explanations apply only to 940 instruments.

Table 8 Detailed explanations

Parameter Explanation

Flow Flow of the high-pressure pump
when starting the method.

Pmin Minimum pressure when starting
the method. If the pressure is
below the entered minimum pres-
sure, the system switches off
automatically.
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Parameter Explanation

Pmax Maximum pressure when starting
the method. If the pressure is
above the entered maximum pres-
sure, the system switches off
automatically.

Start-up time When activated, a start-up time
for reaching the defined flowrate
can be defined.

Number of pumps Determines the amount of con-
nected high-pressure pumps.

Pump A-D To assign the pumps to pumps A-
D.

Eluent A-D Determines the mixing ratio of the
eluents when starting the
method. The total in percent has
always to be 100.

A pump can also be part of an extension module. In this case, the param-
eters are exactly the same as described in this section.

NOTE

The total of the gradient ratios must equal 100%.

Set the instrument parameters of the eluents in such a way that they
result in a total of 100%.

NOTE

Always use pump 1 in a high-pressure gradient.

If pump 1 is active but off, the run does not start.
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IC instrument – Col-
umn heater 

Table 9 Detailed explanations

Parameter Explanation

Wait for Stable Temperature If you switch on this option, a
determination will not start until
the set temperature has been
reached and is stable.

Temperature Temperature that is set for the col-
umn oven when you start the
hardware.

IC instrument –
Degasser 

Table 10 Detailed explanations

Parameter Explanation

On Determines whether the degasser
is switched on or off when you
start the hardware.

A degasser can also be part of an extension module. In this case, the
parameters are exactly the same as described in this section.
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IC instrument – Injec-
tor 

Table 11 Detailed explanations

Parameter Explanation

Position Position of the injection valve
when you start the hardware.

An injector can also be part of an extension module. In this case, the
parameters are exactly the same as described in this section.

IC instrument – MCS 

Table 12 Detailed explanations

Parameter Explanation

On Determines whether the MCS is
switched on or off when you start
the hardware.

An MCS can also be part of an extension module. In this case, the param-
eters are exactly the same as described in this section.
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IC instrument – MSM 

Table 13 Detailed explanations

Parameter Explanation

Automatic stepping to next posi-
tion during equilibration

If you enable this option, then –
after the method is loaded – auto-
matic stepping of the rotor to the
next position is initiated within the
equilibrate mode. The time inter-
val defined in the parameter inter-
val is used.

Interval Time interval between 2 sequen-
tial automatic rotor stepping oper-
ations.

Dosino regeneration

Table 14 Detailed explanations

Parameter Explanation

Dosing device Selection of the dosino that
regenerates the suppressor.

Dosing Port Port for regeneration solution.

Volume Volume of solution 1 or solution 2
for the regeneration of the sup-
pressor in milliliter.

Time The parameter defines for how
many minutes the suppressor
chamber is used.
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Parameter Explanation

Dosing rate Dosing rate, at which the suppres-
sor is regenerated or rinsed in mil-
liliter per minute. It is automati-
cally calculated from the values of
volume and time.

Fill Port Port for filling regeneration solu-
tion.

NOTE

It is possible to use a dosino as a suppressor dosino for MSM regenera-
tion. Therefore, use a dosino that is connected to the IC instrument.
Dosino regeneration with a dosino connected to a sample changer or
eluent production module is not possible.

An MSM can also be part of an extension module. In this case, the param-
eters are exactly the same as described in this section.

IC instrument – Peri-
staltic 

Table 15 Detailed explanations

Parameter Explanation

Rate Rate of the peristaltic pump when
you start the hardware.

On Determines whether the peristaltic
is switched on or off when you
start the hardware.

A peristaltic pump can also be part of an extension module. In this case,
the parameters are exactly the same as described in this section.
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6.2.3 Time program 
The actions, which an IC instrument can perform, depend on the instru-
ment type.

This window shows the commands of the IC instrument (depending on
the instrument type).

Start the data acquisition with Measure Conductivity.

Time program for the gradient

Enter the steps of the gradient profile in chronological order. They are not
sorted automatically.
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6.3 Eluent production module

6.3.1 Manual control

NOTE

It is not possible to produce several eluents at the same time in the
manual control.

When you start producing the second eluent, the production of the first
eluent is stopped immediately.

6.3.2 Instrument parameters 
With up to 3 connected dosinos and up to 4 level sensors, eluents can be
produced in an automated fashion on the one hand, and the fill levels in
storage and waste vessels can be monitored on the other hand.

The eluent production module has 2 functions.

￭ Eluent production
￭ Monitoring of the level sensor

Eluent production

NOTE

Choosing a dosing device is a precondition for eluent production.
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Table 16 Detailed explanations for the parameter "Mode"

Parameter Explanation

Mode: Full Sensor (with short rods) indicates
when the monitored vessel is fil-
led. When the vessel is not full,
the eluent production module
produces as much eluent as nec-
essary to fill the vessel. In the Full
mode, small portions of eluent are
produced at short intervals.

Mode: Empty Sensor (with long rods) indicates
when the monitored vessel is
nearly empty. The eluent produc-
tion module produces as much
eluent as defined to fill the vessel.
In the Empty mode, a bigger por-
tion of eluent is produced at lon-
ger intervals than in the Full
mode.

Table 17 Detailed explanations for the "Empty" mode

Parameter Explanation

Dosing Device Choose a dosino that is used for
eluent production. Assign it to the
respective level sensor.

In this list, you can select only
dosinos that are connected to an
MSB connector of the eluent pro-
duction module.

Eluent volume Indication how many milliliter of
eluent are to be produced.

Waiting time Time in minutes that must elapse
before data for a determination is
recorded again with the newly
produced eluent.
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Table 18 Detailed explanations for the "Full" mode

Parameter Explanation

Dosing Device Choose a dosino, which is used
for eluent production. Assign it to
the respective level sensor.

In this list, you can select only
dosinos that are connected to an
MSB connector of the eluent pro-
duction module.

NOTE

A dosino, which is used as eluent production dosino, must be connec-
ted to the eluent production module.

A dosino connected to an eluent production module can only be used
as eluent production dosino.

The following table lists the parameters for eluent production. They are
relevant for Full and Empty mode. The parameters can be defined after
defining a dosing device.

Table 19 Detailed explanations for the component concentrations

Parameter Explanation

Concentration Concentration of the respective
component in the concentrate or
in the eluent.

You can select in which unit the
concentration will be displayed in
the report.

Target Concentration Target concentration of the
respective component in the fin-
ished eluent. The input range
applies to the first component in
the table. The target concentra-
tions of the additional compo-
nents are calculated by applying
the dilution factor required for the
first component.

You can select in which unit the
target concentration will be dis-
played in the report.
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Procedure of the eluent production

The port assignment is fixed.

Port 1 Concentrate

Port 2 H2O / UPW

Port 3 Eluent

Port 4 Waste

Step Port Action Description

1 4 ejecting Remaining eluent in the cylinder is discar-
ded

2 3 aspirating
0.2 mL of
eluent

For compensating a change of direction

3  waiting 2
s

 

4 2 aspirating
5 mL H2O

Adding H2O in order to improve the sub-
sequent mixing of concentrate and H2O

5  waiting 5
s

 

6 1 aspirating
concen-
trate

The volume of the concentrate is calcula-
ted on the basis of the data in the compo-
nent table and aspirated

7  waiting 5
s

Mixing concentrate and H2O

8 2 aspirating
H2O

The volume is calculated on the basis of
the data in the component table; the elu-
ent has a defined target concentration

9  waiting 5
s

Mixing the eluent

10 3 ejecting The eluent is transferred to the eluent bot-
tle
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Step Port Action Description

11  Repeat-
ing steps
1 to 10
or inter-
rupting

Empty Mode

Repeating in the
workplace if eluent
volume not ach-
ieved

Interrupting in the
workplace if eluent
volume achieved.
The waiting time
until the next deter-
mination is
observed

Full Mode

Repeating in the
workplace if sensor
= 0

Interrupting in the
workplace if sensor
= 1

Monitoring of the level sensor

Level sensor monitoring is only possible if the dosing device is not
defined.

The level sensor that is connected to the eluent production module moni-
tors the fill level.
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Table 20 Detailed explanations for the parameter "Mode"

Parameter Explanation

Mode: Full Sensor (with short rods) indicates
when the monitored vessel is fil-
led.

The Full mode is activated for
level sensors that are installed on
a waste canister, for example.

Mode: Empty Sensor (with long rods) indicates
when the monitored vessel is
nearly empty.

The Empty mode is activated for
level sensors that are installed on
a storage vessel (e.g. with water
for dilution).

Table 21 Detailed explanation for "Monitoring"

Parameter Explanation

Display Message A message is displayed in the
message center if the level sensor
responds.

Record Message A message is recorded in the post-
run report if the level sensor
responds.

Finish determination and stop
device

The ongoing determination is fin-
ished and then the instruments
are stopped if the level sensor
responds.

Cancel determination and stop
device

The ongoing determination is can-
celed automatically and all devices
are immediately stopped if the
level sensor responds.

NOTE

Refer to the following manual for more information regarding the elu-
ent production module:

MagIC Net 3.2 (8.102.8077EN)
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6.4 Dosino

6.4.1 Status panel

NOTE

The Dosino(s) Status panel appears in only 2 cases.

￭ A dosino is used for a dose-in gradient.
￭ A dosino is used as a suppressor dosino for MSM regeneration.

All other dosino activities are described in the manual control under the
respective instrument.

In the Dosino(s) Status panel, you can see the status of the dosino.

6.4.2 Instrument parameters
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Table 22 Detailed explanations "Hardware"

Parameter Explanation

Serial Number Shows the serial number of the
dosing unit.

Cylinder Volume Shows the cylinder volume for the
dosing unit in milliliter.

Table 23 Detailed explanations "Tubing Parameters"

Parameter Explanation

Dosing Port Port to be used as dosing port.

Length Length of the tubing on the dos-
ing port in centimeter.

Diameter Dosing Rate Diameter of the dosing rate in mil-
liliter per minute.

Table 24 Detailed explanations "Valve"

Parameter Explanation

Rotating Direction Rotating direction of the valve
disk. Automatic is the rotating
direction with the shortest path.

Not Over Selection of a protected port that
is not crossed during rotation.

NOTE

The dosing devices (dosinos) have to be connected to the instrument
before you set up the system, because they are not plug-and-play
instruments.

You can connect the dosinos to the following instruments:

￭ IC instrument
￭ Stand-alone detectors
￭ Sample processors

Connecting dosinos to the sample center is not possible.

NOTE

Dosino default settings normally do not require any modification.
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NOTE

If you perform a prep or empty command with the dosino, then the
Dosing Port 1 will always be used as the port for ejecting the solution
(port for prep/empty).

6.4.3 Time program 

This window shows the commands of the Dosino.
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6.5 Remote box

NOTE

Connect the remote box only to the IC instrument or to the Professional
Detector Vario.

Do not connect the remote box to a sample changer.

6.5.1 Instrument Parameters 
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Table 25 Detailed explanations

Parameter Explanation

Output signal Input of the binary pattern for the
output signal of exactly 14 bits.

0 = Output line deactivated

1 = Output line activated

* = Retain the status of the output
line

p = set pulse (pulse length = 200
ms). If an impulse with a different
length is to be emitted, you can
enter the desired value in the field
Pulse Length.

The output lines are numbered
from right to left:
13-12-11-10-9-8-7-6-5-4-3-2-1-0

Examples:

********1***** : Sets the status of
output line 9 on active.

****0********* : Sets the status of
output line 5 on inactive.

6.6 Conductivity detector

6.6.1 Instrument parameters 
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Table 26 Detailed explanations

Parameter Explanation

Temperature Coefficient Temperature coefficient that is set
when you start the hardware. The
temperature coefficient corrects
the measured conductivity of the
detector at the operating temper-
ature to the conductivity at the
reference temperature 20 °C.

Cell Temperature Selecting thermostat temperature
of the detector block.

Cell Constant Cell constant of the measuring
cell. The cell constant is read from
a chip in the detector. You can
change the value if necessary.

NOTE

When changing the cell constant, the value does not update automati-
cally. Close and restart Run Samples to display the new cell constant
value.

For internal conductivity detectors, the parameters are exactly the same as
described in this section.
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6.7 Amperometric detector

6.7.1 Manual control

Operate the amperometric detector individually in the manual control.

6.7.2 Instrument parameters

Table 27 Detailed explanations

Parameter Explanation

Mode Selection of the measuring mode
of the amperometric detector. Fol-
lowing measuring modes are
available:

￭ DC: Measurement with con-
stant potential.

￭ PAD: Measurement with sev-
eral potential steps.

￭ flexIPAD: Measurement with
flexible potential steps (levels,
ramps) and integration.
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Parameter Explanation

Temperature Temperature that is set in the
detector when you start the hard-
ware.

Monitor Temperature Stability If this option is switched on, then
a determination will not start until
the set temperature has been
reached and is stable.

If this option is switched off, then
the sequence of a determination
will not be influenced by the tem-
perature. An attempt will indeed
be made to achieve the tempera-
ture and to maintain it, but the
determination will begin in any
case.

Settings Opens the dialog for setting the
parameters of the selected meas-
uring mode of the amperometric
detector. For further information
concerning the settings for the
different modes, see next section.

Settings for the differ-
ent measuring modes

Several measuring modes are available. Select the desired mode. Click on
[Settings] to change the parameters.

DC 
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Table 28 Detailed explanations

Parameter Explanation

DC Potential Potential of the working electrode
in comparison to the reference
electrode.

Range Selection of the measuring range.

auto: Automatic setting of the
measuring range. This selection is
not allowed with damping activa-
ted.

Damping Switching the auxiliary damping
on or off.

PAD 

Table 29 Detailed explanations

Parameter Explanation

Duration Duration of the potential step in
milliseconds.
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Parameter Explanation

Sum Duration Cumulative duration of potential
steps 1 - n in milliseconds (n =
number of the observed potential
step).

Potential Potential of the step in volts.

Cycle Duration Display of the total duration of
the potential profile in millisec-
onds (sum of the durations of the
individual steps).

Duration Duration of the measurement.

Range Selection of the measuring range.

FlexIPAD 
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Table 30 Detailed explanations

Parameter Explanation

Duration Duration of the potential step in
milliseconds.

Sum Duration Cumulative duration of potential
steps 1 - n in milliseconds (n =
number of the observed potential
step).

Start Potential Start potential of the step in volts.

End Potential Terminal potential of the step in
volts.

Cycle Duration Display of the total duration of
the potential profile in millisec-
onds (sum of the durations of the
individual steps).

Start Start time of the measurement.

End Ending time point of the measure-
ment.

Range Selection of the measuring range.

For internal amperometric detectors, the parameters are exactly the same
as described in this section.
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6.7.3 Time program

This window shows the commands of the Amperometric Detector.

6.8 UV/VIS Detector

6.8.1 Manual control

Define spectra

Set parameters

 

1 Enter parameters for the UV/VIS detector.

These parameters are used for every method. You only need to set
them once.
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Table 31 Detailed explanations

Parameter Explanation

Integration Duration (Int. Dura-
tion)

Time until the next reading of
each diode in milliseconds.

Intensity level Intensity level of the VIS lamp.
Range from 1 to 8.

Spectrum Baseline spectrum: The last
baseline spectrum that has
been recorded.

Intensity spectrum: Current
intensity spectrum.

Absorbance spectrum: Current
absorbance spectrum.

NOTE

Refer to the following manual for more information.

MagIC Net 3.2 (8.102.8077EN)

 

2 Click [Set].

 

3 A dialog window opens. Enter the password MIC9100 to confirm
the change of the intensity level of the VIS lamp and the change of
the integration duration. Click on [OK].
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Auto adjust

NOTE

Only use Auto Adjust, if all of the following preconditions are met.

￭ The UV lamp has been burning for at least 30 minutes.
￭ The flow-through cell is clean.
￭ The flow-through cell is rinsed with ultrapure water.
￭ The flow-through cell is free of air bubbles.
￭ The intensity spectrum has been checked and shows a cut-off.

As an alternative to the manual adjustment, the settings can also be adjus-
ted automatically.

Click on Auto Adjust to adjust the settings automatically.

A built-in algorithm of the instrument carries out the adjustment. This cal-
culates and sets optimized values for the Integration Duration and
Intensity Level.

A new intensity spectrum is displayed after the adjustment.

NOTE

Refer to the following manual for more information.

944 Professional UV/VIS Detector Vario (8.944.8001EN)

6.8.2 Instrument parameters
Absorbance detector 
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Table 32 Detailed explanations

Parameter Explanation

Channel 1-8 Indicates the number of a chan-
nel. When writing a time pro-
gram, you have to choose a chan-
nel by its number. You can meas-
ure up to 8 channels in parallel.

Wavelength Entry of the wavelength of the
channel in nanometer.

Bandwidth ± Subtracting and adding the band-
width to the wavelength gives the
actually measured wavelengths.

Example: If the wavelength of the
channel is 390 nm and for band-
width ± the value 5 nm has been
entered, then the channel compri-
ses the interval 385 - 395 nm.

Measuring Duration Entry of the measurement dura-
tion per data point in milliseconds.

Use Reference Channel Determines whether a reference
channel is used in the determina-
tion. If you do not use a reference
channel, the properties previously
defined for a reference channel
will be retained.

If you use a reference channel, the
absorbance of the reference chan-
nel is subtracted from the signal
of each channel.

UV lamp
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Table 33 Detailed explanations

Parameter Explanation

On Determines whether the lamp is
switched on or off when you start
the hardware.

VIS lamp 

Table 34 Detailed explanations

Parameter Explanation

On Determines whether the lamp is
switched on or off when you start
the hardware.

6.8.3 Time program 

This window shows the commands of the UV/VIS Detector.

Define the wavelength under Measure Spectra.
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6.9 Sample processor

6.9.1 Manual control

Peripherals tower

Table 35 Detailed explanations

Parameter Explanation

Rack position Defines the position on the rack.
Click on the [Start] button behind
Rack move to move the rack.

Lift position Defines the lift position in mm.
Click on the [Start] button behind
Lift move to move the lift.
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Parameter Explanation

Arm position The needle of the sample pro-
cessor can move to external posi-
tions such as the rinsing station.
Adjust external positions in the
manual control. Use the adjusted
external positions in the instru-
ment method.

Arm position defines the posi-
tion of the robotic arm in °.

Click on the [Start] button behind
Arm move to move the arm.

6.9.2 Instrument parameters 
Sample processor –
Peripherals tower 

Table 36 Detailed explanations for Lift Positions

Parameter Explanation

Home The home position is usually the
uppermost stop of the lift.

Work Usually at this lift position the
sample is taken.

Rinse This lift position is used for rinsing.
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Parameter Explanation

Shift Each time that the rack shifts, the
lift will move to this position if it is
located at a lower lift position. If
the lift is located at a higher lift
position than that defined here,
then the shifting will take place at
the current lift position. This
means that the shift position must
be selected so that a safe move-
ment across the entire rack is pos-
sible at any time.

Special This additional definable position
can be used e.g. during pipetting
so that the tip is just immersed in
the sample solution.

NOTE

The lift positions are dependent on the racks and sample vessels used.

Detailed explanations for "Swing Head"

The Swing Head section shows the external positions that you use to
access the positions of the liquid handling station.

You can adjust external positions in the manual control (see Chapter
6.9.1, page 63) and use adjusted external positions in the instrument
method.

Sample processor –
peristaltic pump 

Table 37 Detailed explanations

Parameter Explanation

On Determines whether the peristaltic
pump is switched on or off when
you start the hardware.

Rate Rate of the peristaltic pump when
you start the hardware.
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6.9.3 Time program 

This window shows the commands of the Sample Processor.

In the time program of the peristaltic pump and the peripherals tower, you
can set the same parameters as in the manual control.

6.10 Sample center

6.10.1 Manual control

Set parameters in the configuration

Set the parameters for injector, needle and syringe in the Configuration
part of the Manual Control window.

You can set all parameters for the sample center in the same manner.

 

1 Enter parameters for the sample center.

 

2 Click [Set].

 

3 A dialog window opens. Enter the password MIC9100 to confirm
that you want to change parameters. Click on [OK].
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These parameters are used for every method. You only need to set
them once.

Injector 

Table 38 Detailed explanations for "Configuration"

Parameter Explanation

Sample Loop Volume Volume of the sample loop of the
injection valve, in microliter.

Note: If you operate the instru-
ment in the full loop mode, the
injection volume in the sample
table has to fit to the entered
value in the field
Sample Loop Volume

For further information refer to
the 889 Sample Center user man-
ual.

Table 39 Detailed explanations for "Manual control"

Parameter Explanation

Inject / Fill Position of the injection valve.

Click on [Inject] or [Fill] to switch
between the positions.
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NOTE

The range of the injection volume is depending on the injection mode.
If the volume is outside the respective range, the instrument switches to
failure. The maximum injection volume is calculated in accordance with
the following formulas:

￭ Full loop: injection volume = sample loop volume
￭ Partial loopfill: max. injection volume = 0.5 × sample loop volume
￭ Pickup: max. injection volume = (sample loop volume – 3 × needle

volume) / 2

Needle 

Table 40 Detailed explanations for "Configuration"

Parameter Explanation

Volume Needle to Valve Whole volume, from the needle
tip to the injection valve, in micro-
liter.
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Table 41 Detailed explanations for "Manual control"

Parameter Explanation

Position Display of the current needle posi-
tion and selection of a (different)
needle position.

￭ Top: Vertical movement of the
needle to the top.

￭ Bottom: Vertical movement of
the needle to the bottom. If
the needle is located above a
rack position, it will be moved
to the bottom so far that the
distance between the needle
tip and the bottom of the vial
specified in the parameter
Needle height is reached.

￭ Wash position: Horizontal
movement of the needle to the
wash position.

￭ Waste position: Horizontal
movement of the needle to the
waste position.

￭ Exchange position: Movement
of the needle to the exchange
position.

Height Display of the current value of the
needle height and input of a (dif-
ferent) needle height.

Syringe 
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Table 42 Detailed explanations for "Configuration"

Parameter Explanation

Syringe Volume Display of the volume of the
syringe in microliter.

Buffer Loop Volume Volume of the buffer loop in
microliter. The Buffer Loop Vol-
ume is between 1 µL and 9999
µL.

NOTE

The buffer loop volume and the syringe volume have to match. Check
that the volumes correspond to one of the combinations in the follow-
ing table.

Table 43 Detailed explanations for "Manual control"

Parameter Explanation

Command Selection of the required action of
the syringe.

￭ Fill
￭ Eject
￭ Aspirate
￭ Dispense

Volume If the command Aspirate or Dis-
pense has been selected, the vol-
ume in µL has to be entered here.

Port Display of the current position of
the syringe valve and selection of
a (different) position of the syringe
valve.

￭ Needle: Port to the needle.
￭ Wash: Port to the wash con-

tainer.
￭ Waste: Port to the waste con-

tainer.

Speed Selection of the syringe speed
when carrying out the selected
command.
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Table 44

Syringe volume Buffer Loop volume

250 µL 500 µL

500 µL 1'000 µL

1'000 µL 2'000 µL

NOTE

Refer to the following manual for further information about the sample
center.

889 IC Sample Center (8.889.8001EN)

6.10.2 Instrument parameters 

NOTE

Needle or rack commands can only be processed if the door of the
sample center is closed. If the door is open, the state of the module
changes to Error. The red LED on the sample center and a correspond-
ing message in the message center indicate the error. In this case, go to
Manual Control and select the command Reset Device in the folder
General. If the command Reset Device does not work, reset the sys-
tem (see Chapter 16, page 113).

NOTE

Set further parameters for the sample center in the Manual Control
(see Chapter 6.10.1, page 66).

Compressor 
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Table 45 Detailed explanations

Parameter Explanation

On Determines whether the compres-
sor is switched on or off when
you start the hardware.

Cooling 

Table 46 Detailed explanations

Parameter Explanation

On Determines whether the cooling is
switched on or off when you start
the hardware.

Temperature Temperature that is set for the
cooling when you start the hard-
ware.

Injector 

Table 47 Detailed explanations

Parameter Explanation

Position Position of the injection valve
when you start the hardware.

Needle 
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Table 48 Detailed explanations

Parameter Explanation

Needle Height Vertical distance of the needle tip
from the bottom of the vial or the
cavity of the micro titer plate.

NOTE

Refer to the following manual for further information about exchanging
the needle.

889 IC Sample Center (8.889.8001EN)

Rack 

Table 49 Detailed explanations

Parameter Explanation

Type Selection of the rack type.

NOTE

It is necessary to define the rack in the Instrument Method Editor
and in the tab Define Plates for Sample Method. Make sure that
you choose the same number of vials in the
Instrument Method Editor and in the tab
Define Plates for Sample Method.

You find the tab Define Plates for Sample Method in the Run
Samples section.

Syringe All parameters for the syringe have to be defined in the configuration part
of the manual control.
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6.10.3 Time program 

This window shows the commands of the IC Sample Center.

6.10.4 Import predefined plates 

1 Go to the Configure the System section.

 

2

Go to Plate Types.

Right-click in table. Select Import Plate Type From Text File.

Enter a name for the new plate type.

Click on [Browse].
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3

Navigate to the installation medium. Open the folder Plate Types.

Select a file.

NOTE

Metrohm 6.2041.200 contains a predefined plate with 48 vials.

Metrohm 6.2041.210 contains a predefined plate with 12 vials.

Click on [Open].

 

4

Go to the Run Samples section.

Click on the plates symbol.
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5

Select the newly imported plate in the drop-down list.

6.10.5 Define plates for sample set method 
It is possible to define plates if the required plates are not predefined.

The following screenshots show the definition of the 48 vial rack for the
sample center.

Configure the sample center in the Run Samples section.

NOTE

Pay attention to select the correct Plate Sequencing Mode.

1

To enter the configuration, click on the Plates symbol in the Run
Samples section and click on Create New Plate Type.
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2
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6.10.6 Define the sample positions when measuring 2 channels
When measuring 2 channels (with 2 different solutions, e.g. anions/cati-
ons) with 1 time program, you have to define the sample positions for
standards in the time program.

NOTE

If you are using the +1 command as described in the following section,
you cannot use a predefined injection mode (e.g. Full Loop Injection). In
this case you have to write the sequence for the injection manually.

When adding a Move to Position command, check the checkbox +1.

Checking the checkbox +1 has the following meanings:

￭ LA1+1=LB1
￭ LF1+1=LA2
￭ LF8+1=RA1
￭ RF8+1=RA9 (is invalid)
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7 Creating an offline method 

NOTE

It is not recommended to create an offline method. Use an online
method whenever possible.

The offline method allows you to create a method without any instru-
ments connected to your PC. The following prerequisites have to be fulfil-
led that you can create an offline method and afterwards use it for your
analysis:

￭ When creating an offline method, no instrument has to be connected
to the PC. If an instrument is connected to the PC, setting up an offline
method is not possible.

￭ Ensure that the configuration of the node and the system correspond
with the real system you want to connect to the PC afterwards. Other-
wise there will be an error message when you try to use the method
for your analysis.

To create an offline method proceed as follows:

1 If not yet done, disconnect all Metrohm instruments connected to
the PC.

 

2 Create a new node (see "Creating a node ", page 9).

 

3 Insert the parameters for the DHCP. In case, you want to use the
method for your analysis afterwards, ensure that the values corre-
spond with the real system values.

 

4
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Right-click on Instrument. Click on Add Instrument.

 

5

Select the desired instrument in the drop-down list Type. If you want
to connect any MSB instruments, select them in the drop-down lists.
The numbers belong to the following instruments: 770 Remote Box,
800 Dosino.

 

6 Click on Apply in the lower right corner. If the button is not visible,
maximize the window.

 

7 If desired, add more instruments by right-clicking on Instrument
(see Chapter 2.1, page 3).

NOTE

It is not possible to select the amount of detectors.

A single channel IC instrument contains always 1 amperometric
detector and 1 conductivity detector.

A dual channel IC instrument contains always 2 amperometric
detectors and 2 conductivity detectors.
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8 Creating a processing method 

1

Click on Edit ▶ New Method Set.

 

2
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Click on [Edit] in the line Default Processing Method.

The following window appears.

 

3 Select the processing type and the integration algorithm. Click on
[OK].

 

4

Open the tab Components to perform the following actions.

￭ Make a list of the analytes and their retention time.
￭ Define the retention times of the analytes.
￭ Define the desired calibration parameters.

Adjust the processing method later. It is not necessary to fill in all
parameters. It is possible to start with the default settings.
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5

Enter the levels of your standard solutions on the tab
Default Amounts.

 

6

Set the integration parameters on the tab Integration.

 

7
Save the processing method by clicking on [Save]. 
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8

Enter a name for the processing method. Click on [Save].
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9 Forming a method set 

1

Click on Edit ▶ New Method Set....

 

2
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Select your Instrument Method for the Method Set.
Default Processing Method, Default Report Method and
Export Method are optional.

NOTE

If you measure 2 different channels simultaneously, select them in
the tree view Data Channels and drag them to the table
beneath. You can assign to each channel a processing method.

 

3
Save your method set by clicking on the [Save] button. 

 

4

Enter a name for the method set. Click on [Save].
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10 Running samples 

10.1 Creating a sample table and starting the analysis 

NOTE

The Instrument Status must be IDLE before starting a measuring ser-
ies.

If the instrument is not IDLE, refer to chapter 16, page 113.

1

Start filling in the sample table.
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￭ Start with a line for equilibration of the system. Use the
Equilibrate function for this.

Enter a long run time (e.g. 30 min). This makes sure that the system
has a stable baseline before moving on to the next line.

 

2

Create a sample table according to your needs.

 

3 To start the series, click on the [Run] button (only if the instrument

status is IDLE).
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4

Enter a name for the sample set and click on [Run].

NOTE

For information regarding the shutdown method, refer to Chapter
10.2, page 92.
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When your baseline is stable, you can click on Abort  and select the
Abort run and continue on next line option. This results in a short
stop of all modules.

The different abort options have the following results:

￭ Abort Now: The current run including all modules stops immediately.
Some values in the status window are frozen.

￭ Abort after Vial is completed: The run stops after completing all
injections from the current vial, on the current row in the samples
table. The modules do not stop.

￭ Abort after Injection is completed: The run stops after completing
the current injection. The modules do not stop.

￭ Abort current run and continue on next line: The run including all
modules stops on the current row. Then, the run continues acquisition
with the next row in the sample set method.

NOTE

If you select a shutdown method (see Chapter 10.2, page 92) and do
not activate the option Do not Run Shutdown Method During
User Abort, the shutdown method is executed subsequently.
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10.2 Using a shutdown method 

A shutdown method is downloaded to the instrument at the end of the
sample set. This allows the user to deactivate not used instruments.

Creating a shutdown method

To create a shutdown method, proceed as follows (example):

1 Create a new instrument method (see Chapter 6, page 30).
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2

Switch off the following instruments by unchecking the checkbox
On:

￭ Column Heater
￭ Degasser
￭ MCS
￭ Peristaltic
￭ Pumps

NOTE

Do not uncheck the checkbox Active.

 

3

Open MSM and uncheck
Automatic stepping to next position during equilibration.

 

4 If you are using the amperometric detector: Open the
Time Program.

 

5 Click [Add].
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6

Go to Professional Detector Vario ▶ Amperometric Detec-
tor ▶ Cell On/Off.

 

7 Uncheck Cell On and click [OK].

 

8 If you are using the UV/VIS detector: Open the UV/VIS detector.

 

9

Open UV-Lamp and uncheck the checkbox On.

 

10

Open VIS-Lamp and uncheck the checkbox On.

 

11 Save the instrument method.

Restrictions 

When using a shutdown method, take into consideration the following
restrictions:
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￭ Empower® shows status IDLE and accepts user input while the time
program might still be running. Before starting a new sample set,
ensure that the shutdown method is finished.

￭ In case of a shutdown method, Empower® does not pass sample loca-
tion information. So any time program entry that tries to use this infor-
mation will fail. Example: The command Move to position in the time
program in the picture will not be executed and the time program fails.

￭ When you use a shutdown method at the end of a sequence in a dual
system, an instrument failure occurs. Use a normal instrument method
instead of a shutdown method. Set the instrument parameters for the
last sample line in the same way as you would set them in the shut-
down method.
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11 Measuring cations 

For non-suppressed cation determination, the peaks in the live display are
negative. In the analysis results, the chromatograms are displayed correctly
(with positive peaks), if you use a derived channel. For anion determina-
tion, the peaks are always positive.

If you measure the analytes as negative peaks, the chromatogram has to
be inverted by means of a derived channel. This means that the conduc-
tance measured is multiplied by -1. In order to swap the chromatogram,
modify the method set as follows.

1

Open the desired method set by clicking on Edit ▶ Open Method
Set....

 

2 Create a derived channel by right-clicking on Derived Chan-
nels ▶ New ▶ Derived Channel.
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3

For the derived channel, the conductivity needs to be multiplied by -1
to obtain the inverse:

 

4

Give the derived channel a name.
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5

Choose a processing method for the cation channel.
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12 Equilibrating the system 

You can use the method, which you use afterwards, for the analysis to
equilibrate the system. For this purpose add the function Equilibrate to
the sample table. In this case, only the commands to start data acquisition
(e.g. Measure Conductivity, Measure Current, Measure Charge) of
the time program will be executed. The other commands of the time pro-
gram will not be executed.

Additionally it might be useful to create an Equilibration method. For
this purpose create an instrument method named Equilibration (all
parameters as desired, e.g. pump flow 0.7 milliliter per minute, MSM
autostep all 10 minutes etc.). In the time program enter just 1 line to start
data acquisition to be able to monitor the baseline during equilibration.

Create also a method set Equilibration. You can run this method set in
the 1st line of each sample table.
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13 Evaluating recorded data 

1

To review recorded data, go to [Browse Project] in the Empower®
start window.
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2

Select the desired project in the project tree and click on [OK].

 

3

Right-click on the name of the sample set and choose review.
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4

The  icon shows the calibration.

 

5

Load several results into the review by highlighting them and then

opening the review window. Use the  icon to overlay curves.
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6

For a report, right-click on the desired sample and select
Preview/Publisher.

 

7
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A selection window appears in which you can select an appropriate
Report Method:

 

8

Modify the report as required by using the Edit Method button.

 

9 Apply the information directly to the report by double-clicking on the
corresponding fields.
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Example
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Among many other things, the report can contain the chromatogram, the
calibration curve, instrument parameters (e.g. information on the column
and the cell used) as well as the time program.
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NOTE

For more detailed information on reprocessing and reporting, refer to
Empower® manuals from Waters.
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14 Numbering of the modules

The numbering of each module is depending on its position in the daisy
chain. The daisy chain defines how multiple modules are wired together in
sequence.

￭ For the IC instrument this means: The upper module always gets the
number 1, the lower module number 2 (for pumps and injectors).

￭ For the extension modules this means: Only 1 extension module can
be connected directly to the IC instrument. The 2nd extension module
has to be connected to the 1st. The 3rd extension module has to be
connected to the 2nd. The numbering of the modules begins with the
IC instrument and continues with the extension modules according to
their position in the daisy chain.

NOTE

The numbering is fix. You cannot change it manually.

The following illustrations show the numbering of the modules for differ-
ent system configurations.

In the status panel, all modules with the same number are listed in 1 col-
umn.

Example

The following status panel shows an instrument configuration with a dual
channel IC Instrument and 2 extension modules.
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Columns 1 and 2 show the state of the IC instrument.

Column 3 shows the state of the 1st extension module.

Column 4 shows the state of the 2nd extension module.

The instrument method editor shows the modules in a tree structure.

NOTE

The numbering of the modules in the instrument editor does not equal
the numbering in the status panel.

In the instrument method editor, the existing modules are counted.
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Example: The extension module 2 is on position 4 in the daisy chain and in
the status panel. The injector of the extension module 2 is labeled with
number 3 (not 4 as the extension module itself). The reason for this is that
the injector of extension module 2 is the 3rd injector in the system. Exten-
sion module 1 does not contain an injector. You can see this in the status
panel.



￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭ 15 Importing example methods

￭￭￭￭￭￭￭￭ 111

15 Importing example methods

1

Go to [Configure the System] in the Empower® start window.

 

2
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Go to File ▶ Restore Project(s) or click on the
[Restore Project(s)] button.

 

3

[Browse] to find the desired project.

 

4 Click on [Next] until finished.

The imported project does not only contain exemplary chromatograms,
but also all instrument methods and processing methods that were used
to record them.
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16 Troubleshooting 

Message Center

1 Double-clicking on the E in the task bar opens the Message Center,
in which error messages are documented.

 

2

A list of all current messages appears (example list).

Stopping the process 

If a system failure occurs or if the connection is lost, proceed as follows to
restart Empower® :

1 Close Empower®.

 

2 Power down all Metrohm instruments.

 

3 Power down and restart the PC.

 

4 Power up all Metrohm instruments.

 

5 Restart Empower® by clicking on the corresponding icon on the
desktop.

 

6 Open Run Samples.



￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭

114 ￭￭￭￭￭￭￭￭

17 Restrictions 

￭ 1 DHCP Configuration may maximally include the following modules:
– 1 Sample changer (889 Sample Center or 858 Sample Processor)
– 1 Professional Detector Vario
– 1 Professional UV/VIS Detector
– 1 Eluent production module
– The number of MSB instruments (e.g. dosinos) depends on the

number of available ports (according to the system configura-
tion).

– 1 IC instrument
￭ The total run time must not exceed the Empower run time plus 10

minutes. Therefore, the last data acquisition has to start within 10
minutes from the beginning of the run time. The last data acquisition
has to end within 10 minutes after the end of the run time. Otherwise
the whole run will abort. Sample preparation is part of the total run
time. Therefore, the following steps must not take more than 10
minutes in total.

– Sample preparation
– Lags between sample preparation and data acquisition
– Lags between several data acquisitions
– Gradient profile data acquisition

￭ If an instrument is busy for more than 10 minutes after the end of data
acquisition, an instrument error occurs. In some cases it is necessary to
run the instrument for more than 10 minutes after recording the nee-
ded data. To avoid the error, leave data acquisition on until the end of
the time program.

￭ Metrohm IC instruments do not support the following Empower sam-
ple options. If selected, they generate an error.

– Inject immediate standards
– Inject immediate samples
– Condition column
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￭ Do not edit a method, if the following conditions are fulfilled.
– Use of 940 instrument with an internal conductivity detector.
– New method with an internal amperometric detector.

If you edit the method, the amperometric detector is not shown in the
status panel. Therefore, it is not possible to control the amperometric
detector.

￭ If logging is turned on, it is necessary to exclude the folder C:\Temp
\Metrohm\Log from the scans of the antimalware software.

￭ Powercycle the system monthly to avoid an instrument failure due to
an overflow of the data counter.

￭ You can only use an already existing instrument method with the same
system configuration the instrument method has been created with.

￭ Only switch between 2 instrument methods, when you use the same
instruments in both methods.
When you use different instruments in 2 methods, stop the system
between the 2 methods.

￭ It is necessary to check manually if the driver reads all connected instru-
ments correctly in a new system or after a restart.

￭ A script error occurs irregularly in the Run Samples section of dual
systems. Close and restart Run Samples when the error occurs.
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